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Application Notes for Nuance OpenSpeech Attendant with
Avaya Interactive Response — Issue 1.0

Abstract

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Interactive Response and Avaya Aura™ Communication
Manager. Nuance OpenSpeech Attendant allows callers to speak the name of a person,
department, service, or location and be automatically transferred to the requested party without
waiting to speak to an operator. This solution uses MRCPvl (Media Resource Control
Protocol).

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Interactive Response and Avaya Aura™ Communication
Manager. Nuance OpenSpeech Attendant (OSA) allows callers to speak the name of a person,
department, service, or location and be automatically transferred to the requested party without
waiting to speak to an operator. This solution uses MRCPv1.

1.1. Interoperability Compliance Testing

The interoperability compliance test included feature and serviceability testing. Feature testing
focused on verifying that Nuance OSA can successfully recognize spoken names and extensions
entered via DTMF and transfer the call to the correct destination. Blind transfers were verified.
Other features covered included barge-in / no barge-in, adding new transfer entries, recording
caller utterances, and accessing Maintenance Mode and Personal Administration Mode to record
name and change PIN. The Nuance Speech Server and Avaya Interactive Response (IR) were
configured to use MRCPv1.

Serviceability testing focused on verifying the ability of the Nuance OSA to recover from
adverse conditions, such as server restarts, power failures, and disconnecting cables to the IP
network.

1.2. Support

To obtain technical support for Nuance OpenSpeech Attendant, contact Nuance via email or
through their website.

= Web: www.network.nuance.com
= Email: SpeechAttendant.Support@nuance.com
= Phone: (866)434-2564 or (514) 390-3922
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2. Reference Configuration

Figure 1 illustrates the configuration used to verify the Nuance OpenSpeech Attendant (OSA)
solution with Avaya Interactive Response (IR), Avaya Aura™ Communication Manager, and a
Nuance Speech Server. Nuance OSA is deployed on a dedicated application server running
Windows 2003 Server, and the Nuance Speech Server was also running on a separate Windows
2003 Server. Avaya IR interfaces to Avaya Aura™ Communication Manager using T1 or Voice
over IP. This solution may be supported with either interfaces, but these Application Notes will
focus on the T1/Robbed-Bit Signaling interface. Avaya IR manages the interactions with
speech server resources (i.e., speech recognition and text-to-speech) used by VXML
applications. VXML pages generated by Nuance OSA are loaded and interpreted by Avaya IR,
which controls the interaction with the user. To access the Nuance OSA application, a voice
channel on Avaya IR must be configured to invoke the VXML application when an incoming
call is received on that channel. Avaya IR and the Nuance Speech Server were configured to use
MRCPvl.

Avaya Aura™ Communication Manager
running on Avaya S8800 Server
(10.32.24.10)

Nuane OpenSpeech Attendant
(10.32.24.141)

\

m

Il

—/
—

Avaya G650 Media Gateway

(CLAN: 10.32.24.20) Nuance Speech Server
(10.32.24.140)

Avaya Interactive Response vaya 9600 Series

(10.32.24.35) IP Telephones

Figure 1: Configuration with Avaya Interactive Response and Nuance OSA

JAO; Reviewed: Solution & Interoperability Test Lab Application Notes 3 of 38
SPOC 11/16/2010 ©2010 Avaya Inc. All Rights Reserved. Nuance-OSA4-IR



2.1. Equipment and Software Validated

The following equipment and software were used for the sample configuration:

Equipment Software
Avaya Interactive Response 4.0 with Service Pack 4
Avaya S8800 Server with a G650 Avaya Aura™ Communication
Media Gateway Manager 6.0 with Service Pack 1
Avaya 9600 Series IP Telephones 3.110b (H.323)

Nuance OpenSpeech Attendant (OSA) | 4.0 with Hotfix 4

Nuance Speech Server

= Nuance Recognizer 9.0.12
= Nuance Vocalizer for Network | 5.0.0
= Nuance Speech Server 5.1.1
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3. Configure Avaya Aura™ Communication Manager

This section describes the configuration of the T1/Robbed-Bit Signaling link between Avaya
Aura™ Communication Manager and Avaya IR and the stations that correspond to each Avaya
IR port. In addition, it covers the configuration of the Hunt Group, Vector Directory Number
(VDN), Vector, and Agent Login-IDs required for this solution. Refer to [1] and [2] for
additional information on configuring Communication Manager. The configuration described
below covers the following capabilities:

= Establish the T1 interface between Communication Manager and Avaya IR.

= Configure stations for the Avaya IR ports. Avaya IR ports are configured as Stations
with type DSIFD.

* Configure the Hunt Group that the Avaya IR ports (i.e., Agent Login-IDs) will log into.

= Configure the Agent Login-IDs for the Avaya IR ports. Stations associated with Avaya
IR ports automatically log into the hunt group via Agent LoginIDs.

= Configure the VDN that receives incoming calls. Inbound calls are routed to VDN 75200
which invokes Vector 200.

= Configure the Vector that is invoked by VDN 75200. Vector 200 queues the incoming
call to Hunt Group 270 with Avaya IR ports. Vector 200 passes the DNIS and VDN
numbers to Nuance OSA which in turn returns the transfer-to number using the
configured Converse Data Return Code.

The following configuration is performed via the System Access Terminal (SAT). On the SAT,
configure the DS1 board that provides T1 connectivity to the Avaya IR. The Signaling Mode of
the DS1 board is set to robbed-bit signaling with a Line Coding and Framing Mode of »8zs and
esf, respectively.

add dsl all Page 1 of 2
DS1 CIRCUIT PACK

Location: 01Al11l Name: Avaya IR
Bit Rate: 1.544 Line Coding: b8zs
Line Compensation: 1 Framing Mode: esf

Signaling Mode: robbed-bit

Interface Companding: mulaw
Idle Code: 11111111
Slip Detection? n Near-end CSU Type: other

Figure 2: DS1 Circuit Pack
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Configure each Avaya IR port as a station with the Type field set to DSI/FD. Repeat this
configuration for each Avaya IR port. These stations will be members of Hunt Group 270
configured in Figure 4. The stations (IR ports) will automatically log into the split via the Agent
LoginlIDs configured as shown in Figure 6. When using the Voice over IP interface on Avaya
IR, the ports are configured as 7434ND stations.

add station 23201 Page 1 of 4
STATION
Extension: 23201 Lock Messages? n BCC: O
Type: DS1FD Security Code: TN: 1
Port: 01A1101 Coverage Path 1: COR: 1
Name: IR Port 1 Coverage Path 2: COS: 1
Hunt-to Station: Tests? y

STATION OPTIONS
Time of Day Lock Table:
Loss Group: 4
Off Premises Station? y
R Balance Network? n

Survivable COR: internal
Survivable Trunk Dest? y

Figure 3: Station for Avaya IR Port

The Avaya IR ports, configured as DS1FD stations, will automatically log into Hunt Group 270.
Set the Group Extension field to a valid extension and enable the ACD and Vector options.
This hunt group will be specified in the Agent LoginIDs configured in Figure 6 and 7.

add hunt-group 270 Page 1 of 3
HUNT GROUP

Group Number: 270 ACD? y
Group Name: Nuance OSA (T1) Queue? y
Group Extension: 77000 Vector? y
Group Type: ucd-mia
TN: 1
COR: 1 MM Early Answer? n
Security Code: Local Agent Preference? n

ISDN/SIP Caller Display:

Queue Limit: unlimited
Calls Warning Threshold: Port:
Time Warning Threshold: Port:

Figure 4: Hunt Group for Avaya IR Ports (Page 1)
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On Page 2 of the Hunt Group form, enable the Skill and AAS options. The AAS option will
allow the IR ports to automatically log into the hunt group via the Agent LoginIDs.

add hunt-group 270 Page 2 of 3
HUNT GROUP
Skill? y Expected Call Handling Time (sec): 180
AAS? y Service Level Target (% in sec): 80 in 20
Measured: internal Service Objective (sec): 20
Supervisor Extension: Service Level Supervisor? n

Controlling Adjunct: none

VuStats Objective:
Timed ACW Interval (sec): Dynamic Queue Position? n
Multiple Call Handling: none

Interruptible Aux Threshold: none
Redirect on No Answer (rings):
Redirect to VDN:
Forced Entry of Stroke Counts or Call Work Codes? n

Figure 5: Hunt Group for Avaya IR Ports (Page 2)

Add an Agent LoginID for each IVR port. The AAS option is enabled and the Port Extension
is set to the extension of the stations corresponding to each Avaya IR port. Repeat this
configuration for each DS1FD station. In this configuration, agent login ID 26201 was created.

add agent-loginID 26201 Page 1 of 2
AGENT LOGINID

Login ID: 26201 AAS? y
Name: IR Port 1 AUDIX? n
TN: 1 LWC Reception: spe
COR: 1 LWC Log External Calls? n
Coverage Path: AUDIX Name for Messaging:
Security Code:
Port Extension: 23201 LoginID for ISDN Display? n

Auto Answer: station

MIA Across Skills: system

ACW Agent Considered Idle: system

Aux Work Reason Code Type: system

Logout Reason Code Type: system

Maximum time agent in ACW before logout (sec): system
Forced Agent Logout Time: :

WARNING: Agent must log in again before changes take effect

Figure 6: Agent LoginID for IVR Ports (Page 1)
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On Page 2 of the Agent LoginID form, set the skill number (SN) to hunt group 270, which is the
hunt group (skill) that the Avaya IR ports will log into.

add agent-loginID 26201 Page 2 of 2
AGENT LOGINID
Direct Agent Skill: Service Objective? n
Call Handling Preference: skill-level Local Call Preference? n
SN RL SL SN RL SL SN RL SL SN RL SL

1: 270 1 16: 31: 46:
23 17: 32: 47
3: 18: 33: 48:
4: 19¢ 34: 49:
5: 20: 35: 50:
6: 21: 36: 51:
7: 22: 37: 52:
8: 23: 38: 53:
93 24: 39: 54:
10: 25: 40: 55:
11: 26: 41: 56:
12: 27: 42 57:
13: 28: 43: 58:
14: 293 44 59¢
15: 30: 45: 60:

Figure 7: Agent LoginID for Avaya IR Ports (Page 2)

Incoming calls will be routed to VDN 75200 based on the DNIS. VDN 75200 will invoke vector
200 which will queue the call to the hunt group containing Avaya IR ports. Avaya IR will
invoke the Nuance OSA application and wait for the transfer-to number. Use the add vdn 75200
command to create the VDN that will handle all incoming calls.

add vdn 75200 Page 1 of 3
VECTOR DIRECTORY NUMBER

Extension: 75200
Name*: Nuance OSA
Destination: Vector Number 200
Attendant Vectoring? n

Meet-me Conferencing? n
Allow VDN Override? n

COR: 1

TN*: 1
Measured: none

Service Objective (sec): 20
VDN of Origin Annc. Extension*:
1st Skill*:
2nd Skill*:
3rd Skill*:

* Follows VDN Override Rules

Figure 8: Vector Directory Number (VDN)
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VDN 75200, configured above, will invoke vector 200 which will queue the call to hunt group
270. The converse-on step is used to pass the ANI and VDN numbers. Communication
Manager will then collect the transfer-to number sent by Nuance OSA. Configure vector 200 as
shown below. These steps are required when using a T1/Robbed-Bit Signaling interface. When
using a Voice over IP interface on Avaya IR, the call is routed to the hunt group using a queue-
to skill step. The converse-on and collect steps should not be used.

change vector 200 Page 1 of 6
CALL VECTOR

Number: 200 Name: Nuance OSA
Multimedia? n Attendant Vectoring? n Meet-me Conf? n Lock? n
Basic? y EAS? vy G3V4 Enhanced? y ANI/II-Digits? y ASAI Routing? y
Prompting? y LAI? y G3V4 Adv Route? y CINFO? vy BSR? y Holidays? n
Variables? y 3.0 Enhanced? y
01l wait-time 2 secs hearing ringback
02 converse-on skill 270 pri h passing ani and vdn
03 collect 16 digits after announcement none for none
04 route-to digits with coverage y
05 stop
06
07
08
09
10
11
12

Press 'Esc f 6' for Vector Editing

Figure 9: Call Vector

Configure the Converse Data Return Code field on Page 7 of the Feature-Access Codes form
as shown in Figure 10.

change feature-access-codes Page 7 of 10
FEATURE ACCESS CODE (FAC)

Call Vectoring/Prompting Features

Converse Data Return Code: #12

Vector Variable 1 (VV1) Code:
Vector Variable 2 (VV2) Code:
Vector Variable 3 (VV3) Code:
Vector Variable 4 (VV4) Code:
Vector Variable 5 (VV5) Code:
Vector Variable 6 (VV6) Code:
Vector Variable 7 (VV7) Code:
Vector Variable 8 (VV8) Code:
Vector Variable 9 (VV9) Code:

Figure 10: Feature Access Codes

Configuration of Communication Manager is complete. Use the save translation command to
save these changes.
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4. Configure Avaya Interactive Response (IR)

This section covers the configuration of Avaya IR. Communication Manager routes incoming
calls to Avaya IR over a T1 interface. Each channel of the T1 interface is assigned a phone

number that should match the corresponding station extensions configured on Communication
Manager and an Avaya IR VoiceXML application. Refer to [3] for additional information on

Avaya IR.

The configuration steps required on Avaya IR are summarized below.

= Access the Avaya IR via a web browser and log in.

= Stop the Voice System (i.e., Avaya IR) prior to configuring the T1 interface.
= Configure the T1 interface to the Avaya G650 Media Gateway.

* Administer and assign an ASR and TTS engine.

= Start the Voice System.
= Assign channels to equipment groups.
= Assign phone numbers to channels.

= Assign services (VoiceXML applications) to channels.

Note: The Nuance OSA solution is also supported with a Voice over IP interface between Avaya

IR and Communication Manager.

interface.

However, the focus of these Application Notes is the T1

The packages installed on Avaya IR are displayed below. To verify which packages are installed
on Avaya IR, use the “pkginfo | grep AV’ command from the command line.

avir (root) #
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
Release 6.1
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR
IVR

pkginfo | grep AV

AVasai
AVasr
AVbackrst
AVctidip
AVftst

AVir
AVijdbcint
AV1m
AVmrcpasr
AVmrcptts
AVmrcpvz2asr
AVmrcpv2tts
AVnms

AVsc

AVsproxy
AVsrproxy
AVtsm
AVttsprxy
AVucid
AVval
AVvoicxml2-0
AVvoip
AVwebadm
AVweblm

Adjunct/Switch Application Interface
Avaya Recognizer - Utilities
Backup/Restore Utilities

CTI Data Interface Process

Feature Test Script Package
Interactive Response Base System
JDBC Integration

License Manager

MRCP ASR Proxy

MRCP TTS Proxy

MRCPv2 ASR Proxy

MRCPv2 TTS Proxy

NMS Package

Service Creation Integration Package

Speech Proxy Base Software

Speech Proxy SR - Speech Recognition
Transaction State Machine

Proxy Text-to-Speech Package
Universal Call ID

Avaya IR System Validation Package
Voice XML Interpreter

Voice Over IP

Web Administration

WebLM Server

JAO; Reviewed:

SPOC 11/16/2010

Solution & Interoperability Test Lab Application Notes 10 of 38
©2010 Avaya Inc. All Rights Reserved.

Nuance-OSA4-IR




IVR AVwebservice Avaya IR Web Services

IVR AVxfer Call Transfer and Bridge Package
system SUNWav1394 IEEE1394 AV Driver

JAVAAPPS SUNWjavaapps A set of Java Demo Applications - j
dictionary, jdiskreport. jedit, Jjgraphpad and jspider

JAVAAPPS SUNWjmf Java Media Framework

JAVAAPPS SUNWimfmp3 JMF MP3 Plugin

Figure 11: Installed Avaya IR Packages

The Avaya IR configuration was performed via a web browser. Enter the IP address of Avaya
IR in the URL field of the web browser. The initial Avaya IR webpage is displayed as shown in
Figure 12. Select the Web Administration link to display the log in screen (not shown), and
log into Avaya IR with the appropriate credentials.

AVAYA

Avaya Interactive Response 4.0

Avaya Interactive Response 4.0

Web Administration
WebLM Primary Server
WeblLM Secondary Server
Help

Figure 12: Initial Avaya IR Screen
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After successfully logging into Avaya IR, the main Avaya IR configuration webpage is displayed

as shown in Figure 13.

|

AVAYA

Interactive Response Web-Administration

b |

Avaya IR 4.0

Interactive Response 4.0

? Help @ Log Off

; Expand All

F ASG Security Administration
kBackup/Restore

* Configuration Management
and Administration

FSystem Control

Renumber Voice Channels
Report Voice System Status
Start Voice System

Stop Voice System

F Switch Interfaces
¥ Voice Equipment
P Vaica Sarvices
FFeature Packages
P ROI-TCO Feature

FRaports

Backup Information

Fdkdcdkgkdohki (| OT]CE *H%kd®hihdghiodts

Mo complete backup has been done.
Mo partial backup has been done.

It is recommended to perform a full system backup every 30
days.

If you fail to do so, you risk losing informaticn on the system
in the event of a catastrophe.

FEEREFERHHE (QT[CE FFEHHHELEE EHHH

System Status

Mormal mode

Optional: Area for display of application messages.
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Prior to configuring the T1 interface to the Avaya G650 Media Gateway, stop the Avaya IR by
selecting the System Control - Stop Voice System link from the left pane in Figure 13. The
Stop Voice System page (not shown) is displayed. Click the Submit button and wait until the
system displays a message at the bottom of the page indicating that the voice system has
completely stopped.

To configure the T1 interface to the Avaya G650 Media Gateway follow these steps:

1. Under Switch Interfaces in the left pane, select the Digital Interfaces option to display the
Digital Interfaces Protocols page (not shown).

2. Select the Assign Card link to display the Assign Card page shown in Figure 14. On this
page, set the Card field to the appropriate number, set the Card Type field to 7/, and set the
Trunk 1 field to Loop Start TI. When complete, click the Submit button to display the
Assign Card 1: Type T1 page shown in Figure 15.

-
AVAyA Avaya IR 4.0
Interactive Response 4.0
Interactive Response Web-Administration 7 Help @ Log Off
; Expand All
F ASG Security Administration ASSIgn Card
} Backup/Restore
} Configuration Management
and Administration Card: |1 v Card Type: | T1 ¥
} System Control Trunk 1: | Loop Start T1 +
¥ Switch Interfaces Trunk 2:| None b
* Digital Interfaces
S _Submit N Reset NN Help |
Change Parameters
Display Parameters
Unassign Card
Help
M Voice over IP
}Voice Equipment
FVoice Services
} Feature Packages
FROI-TCO Feature
} Reports
< >
Optional: Area for display of application messages.
A v |
Figure 14: Assign Card
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On the page shown in Figure 15, set the Frame Type field to ESF and the Line Code field to
B8ZS. Accept the default for the other fields as shown in the figure. Click the Submit button.

AVAYA

Interactive Response Web-Administration

Avaya IR 4.0

Interactive Response 4.0

> |

? Help @ Log Off

' Expand All

} ASE Security Administration
}Backup/Restore

} Configuration Management
and Administration

¥ System Control

* Switch Interfaces
* Digital Interfaces

Systern Parameters

Display Assignments
Assign Card

Change Parameters
Display Parameters

Unassign Card

Help
FVoice over IP

} Voice Equipment
} Voice Services

} Feature Packages
} ROI-TCO Feature

}Reports

< %

Optional: Arez for display of application messages.

h

Assign Card=Assign Card 1

Assign Card 1: Type T1

Common Parameters:
Tdle Code: [ v Length: O
Clock Trunk- v Clock Source:

Clock Mode: E DALONE + | Clock Fallback Trunk: |

Fax Enabled?- o v Enabled Channels: 48 (0 to 48)

Loop Start T1:

Country: |iEfnitedSiates) |

Trunk 1

Frame Type: ESF v Line Code: B8ZS v
|_Reset | |__Help |

[NETWORK ~ +
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Next, configure the Automatic Speech Recognition (ASR) server in Avaya IR by selecting the
Administration option under Speech and DPR Administration in the left pane and then
selecting Speech Recognition and DPR Configuration. For this solution, a Nuance Speech
Server was used as the ASR server. The ASR server should be configured as shown in Figure
16. The following Speech Recognition and DPR Configuration webpage is shown after it was
already configured. The Engine field should be set to mrcp-scansoft (for MRCPv1), the Server
Name and IP Address fields should be set to the IP address corresponding to the Nuance Speech
Server. Furthermore, the Ports field should be set to the number of ports available on the speech
server according to its installed license and the Base Port field should be set to 4900 and
defaults can be used for remaining fields.

Note: If Avaya IR uses the hostname of the Nuance Speech Server to communicate, ensure that
Avaya IR can resolve the hostname to an IP address. In this configuration, an entry was added to
the /etc/hosts file of Avaya IR corresponding to the hostname and IP address of the Nuance
Speech Server, otherwise the recordings of caller utterances could not be retrieved successfully.

‘
AVA A Avaya IR 4.0
Interactive Responses 4.0
Interactive Response Web-Administration ? Help @ Log Off
; Expand All
P ASG Security Administration gﬂﬁ?‘l;ﬁgﬁﬁ:ﬂ?nltlon and D p R
} Backup/Restore
} Configuration Management RCCOgﬂlthﬂ T\'pe OPSR4 |
and Administration EﬂgiIlE' mrcp scansoft
»System Control [ Unassign |
¥ Switch Interfaces . =
» Digital Interfaces Assign New Server
*Voice over IP
Server Name: 10.32.24 140/media’speechrecognizer
}Voice Equipment S T Pri
erver Type: rimary
}Voice 5 i
s IP Address: 10.32.24.140
leatire Pacliies Binding IP Address: | 10.32.24.35
* ASAI Administration
CTI DIP Administration Ports: 4
¥ Speech and DPR Administration
} Display Status Base Port: 4900
¥ Administration - .
R 1 Backup Server: Not Specified
Speech Recognition and DPR C m
Text-to-Speech Configuration
Help | Refresh _Jl _ Help ]
Universal Call ID Administration
F ROI-TCO Feature
» Reports
% *
Optional: Area for display of application messages.
h v |

Figure 16: Speech Recognition and DPR Configuration
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To Configure the Text-to-Speech (TTS) engine in Avaya IR, select the Administration option
under Speech and DPR Administration in the left pane and then select Text-to-Speech
Configuration. For this solution, a Nuance Speech Server was used as the TTS server. The
TTS server should be configured as shown in Figure 17. The following TTS configuration
webpage is shown after it was already configured. In this configuration, the default voice of
samantha was used. The Engine field should be set to mrcp-scansoft (for MRCPv1), the Server
Name and IP Address fields should be set to the IP address corresponding to the Nuance Speech
Server. Furthermore, the Ports field should be set to the number of ports available on the speech
server according to its installed license and the Base Port field should be set to 4900.

N

AVAyA Interal:tiv:“R'::pao:sReq‘;g

Interactive Response Web-Administration ? Help @ Log Off
; Expand All
F ASG Security Administration TEXt_tO_SDEECh Conﬁguratlon
b . .
ar kup/Hesrone Default Voice: samantha ‘
» Configuration Management -
and Administration Text-to-Speech Type:| TTSO |
» System Control Engine: mrcp-scansoft
_Change [l unassion |
¥ Switch Interfaces
} Digital Interfaces
FVaoice over IP Assign New Server
e i _ , .. .
mce bquipment Server Name: 10.32.24.140/media’speechsynthesizer
} Voice Sarvices SEI"VEI’ T\,’pe: anarf
¥ Feature Packages TP Address: 10.32.24.140
P ASAT Administration
T . 7794 15
CTI DIP Administration Binding [P Address: 10.32.24.35
* Speech and DPR Administration Ports: 4
} Display Status
* Administration Base Port: 4900
Change Speech State - .
Backup Server: Not Specified
Speech Recognition and DPR C - P
fFaxitia-Spesch Canfiguration [ Unassign |
Help
Universal Call ID Administration m m
FROI-TCO Feature
} Reports
¢ *
Optional: Area for display of application messages.

| 4
Figure 17: Text-to-Speech Configuration Summary

After the T1 card and speech server are successfully configured, start the Avaya IR by selecting
Start Voice System under System Control in the left pane. Before proceeding, wait for the
system to display a message indicating that the startup of the voice system is complete.
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Next, assign the channels of the T1 card to equipment group ‘2°. Select the Channels to
Groups option under Voice Equipment in the left pane, and then select the Assign link to
display the Assign Channels to Equipment Groups page shown in Figure 18. Assign group
‘2’ to channels 0-23, which corresponds to the 24 T1 channels, and then click Submit.

B |

AVAyA Avaya IR 4.0

Interactive Response 4.0

Interactive Response Web-Administration

? Help @ Log Off

; Expand All
F ASG Security Administration gizll_?::s(:hanne's to Eq'-“pment
* Backup/Restore
Channels: |0-23 |
» Configuration Management = | —r——— |
and Administration GTO'I.IpSI 2

b System Control
Submit Reset m
* Switch Interfaces

T Voice Equipment
Display Equipment

Equipment State
¥ Channels to Groups

Assign
Unassign

Help
*Phone Number

Display Passwords
FVoice Services
} Feature Packages
F ROI-TCO Feature

} Reports

< >

Optional: &rea for display of application messages.

Figure 18: Assign Channels to Equipment Groups
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After assigning channels to groups, assign phone numbers to channels. Select the Phone
Number link under Voice Equipment in the left pane to display the Phone Number — Channel
Assignment page and select the Assign link. Assign phone numbers 23201 to 23204 to channels
0 to 3, respectively, as shown in Figure 19 and then click Submit. If more ports were defined,
more phone numbers could be used.

Avaya IR 4.0
Interactive Response 4.0

AVAYA

Interactive Response Web-Administration

? Help @ Log Off

§ Expand All

} ASG Security Administration

£or Phone Number: 23201 [ro23204 |
¥ Configuration Management Cha_tmel Nurﬂber 0 to |3
I e e e o] S e [ L
VoIP H.323 MultiVantage Station Password: |to |
bSystemContral | e e A
»Switch Interfaces _Reset _JEN  Help |

Assign Phone Number to a Channel

* Voice Equipment
Display Equipment
Equipment State

*Channels to Groups
¥ Phone Number

Assign
Unassign
Help

Display Passwords
} Voice Services
}Feature Packages
FROI-TCO Feature

} Reports

4 *

Optional: Area for display of application messages.

Figure 19: Assign Phone Number
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Now, assign a Nuance OSA application to a channel (e.g., channel 0 was arbitrarily chosen for
this example). This specifies which application a particular Avaya IR channel would run when it
receives an incoming call. Select Voice Services = Channel Services from the left pane to
display the Channel Services page in Figure 20. Enable the checkbox for channel 0 and then
click the Assign Selected button.

e paese i
AVAYA &

Interactive Response Web-Administration ? Help B Log OFf

[ Expand All

» ASG Security Administration Channe' SEI’VICES

» Backup/Restore Select Chan Service/URI Type Startup Service/URI Type
0 - unassigned - unassigned Details
} Configuration Management e ; ; :
and Administration IF 1 unassigned = unassigned Details
] [ 2 unassigned B unassigned Details
] 3 unassigned - unassigned Details
* Switch Interf . =
Y Digital Tnterfaces A unassigned - unassigned  Details
+Vaice aver IP Pl 5 unassigned - unassigned Details
» Voice Equipment O 6 unassigned - unassigned Details
1 i unassigned - unassigned Details
* Voice Services . .
i il 8 unassigned - unassigned Details
Number Services O 9 unassigned - unassigned Details

~ Feature Packages
P ASAI Administration -
o9 ol [ 109
CTI DIP Administration AT Channel Range: | (0-3) Display channels.
* Spaach and DPR Administration

} Display Status ; - d .
} Administration Unselect All Assign Selected Unassign Selected
Universal Call ID Administration m
» ROI-TCO Feature
} Reports
< | >

Optional: Area for display of application messages.

Figure 20: Channel Services
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Configure the Assign Services to Channels page as shown in Figure 21. This configuration
assigns the Nuance OSA application named to channel 0. Set the Assign field to VXML URI, set
the URI field to

http://10.32.24.141/OpenSpeech/Attendant/serviet/aa?avaya_inband anidnis=anything&avaya
acm_fac=%2312, and set the To Chan(s) field to ‘0’. The required parameters in the VXML
URI allow the ANI and DNIS to be passed to the Nuance OSA and also specify the Converse
Data Return Code of ‘#12” configured in Figure 10. Repeat this procedure for all channels that
should run this application. Click Submit.

AVAYA e e

Interactive Response Web-Administration ? Help @ Log Off

Expand All

» ASG Security Administration ASSIgn SEI’VICES to ChaHHEIS

}Backup/Restore Assign
» Configuration Management Primary URT:
and Administration
Backup URI:
»System Control .
DTMF Recognition Mode:
v Switch Interfaces -
» Digital Interfaces Application Name:|
»Voi P
ice over To Chan(s): [0

*Voice Equipment

¥ Voice Services ~ Submit . Reset Cancel m

Channel Services

Mumber Services

~ Feature Packages
» ASAI Administration
CTI DIP Administration
~ Speech and DPR Administration
} Display Status
» Administration

Universal Czll ID Administration

FROI-TCO Feature

»Reports

& | >

Optional: Area for display of application messages.

Figure 21: Assign Services to Channels — VXML Application
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To view the status of the channels and the channel configuration details, select Display
Equipment from the left pane. The page in Figure 22 is displayed. Verify the state of the
configured channels. In this configuration, channels 0-3 are in-service and channel 0 was
assigned to the Nuance OSA application. Channel 0 is assigned phone number 23201.

AVAyA Avaya IR 4.0
Interactive Response 4.0
Interactive Response Web- Administration ? Help @ Log Off
=
A ety A CARD 1  STATE: Inserwv CLASS: Digital NMS(T1) O.S_INDEX: 1
NAME: AGZZ OFTICHS: standalone clocking, no tdm
FUNCTION: MMS
*Backup/Restore CRRD TRUME PORT CHAN STATE SERVICE-NAME THONE GROUF  OFTS FROTOCOL
1 1 o 0 Inserv AVAYAVKIO 23201 z talk LOOE
} Configuration Management 1 1 1 1 Inserv - 23202 z talk LOOP
and Administration 1 1 2 2 Imserv - 23208 2 talk LOOP
1 1 3 3 Inserv - 23204 z talk LOOP
} System Control 1 1 4 4 Foos - - z talk LOOE
1 1 s 5 Foos - - z talk LOOP
¥ Switch Interfaces 1 1 g & Foos - - z talk LOOE
} Digital Interfaces 1 1 7 7 Foos - - z talk LOOE
} Voice over IP 1 1 ] g Foos - - z talk LOOP
1 1 3 3 Foos - - z talk LOOP
~ Voice Equipment 1 1 10 10 Foos - - z talk LOOP
i 1 1 11 11 Foos - - z talk LOOE
e : 1 1 1z 12 Foos - - z talk LOOE
1 1 13 13 Foos - - z talk LOOP
pEhannel =t o 1 1 14 14 Foos - - H talk LOOE
PEITTEITIT b 1 1 15 15 Foos - - z talk LOOP
Display Passvords 1 1 18 & Foos - - z t=lk LOOE
1 1 17 17 Foos - - z talk LOOP
Voice Services 1 1 13 18 Foos - - 3 talk LOOE
1 1 13 15 Foos - - z talk LOOE
~ Feature Packages 1 1 20 20 Foos - - z talk LOOE
» ASAI Administration 1 1 21 21 Foos - - z talk LOOE
CTI DIP Administration 1 1 22 22 Foos - - Z talk LOOE
+ Spaach and DPR Administration 1 1 23 23 Foos - - Z talk LOOE
} Display Status
} Administration
Universal Call ID Administration
» ROI-TCO Feature
}Reports
5 I * b
Optional: Area for display of application messages.

Figure 22: Display Equipment

In Avaya IR, change the client.inet.connection.persistent parameter to ‘0’ in the default0.cfg,
defaultl.cfg, and default.cfg files located in the /vs/data/vxml directory. Stop the voice system
with the stop_vs command and then restart the voice system with the start_vs command.
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5. Configure Nuance OpenSpeech Attendant

This section covers the procedure for configuring Nuance OpenSpeech Attendant (OSA). The
procedure includes the following areas:

=  Administer settings in the Configuration Panel

= Administer transfer entries in the Phone Directory and Menu Editor
= Administer top-level menu in the Phone Directory and Menu Editor
=  Administer Caller Utterance Recordings

Note: The Vocalizer config file, ttsrshclient.xml, located in C: \Program
Files\Nuance\Nuance Vocalizer for Network 5.0\config directory of the speech
server must be tuned to interoperate successfully with Nuance OSA. The tag

<ssml validation> must be set to none. The default value is strict.

Nuance OSA is configured through Admin Tools which can be started by navigating to
Start->Nuance-> Admin Tools. The initial screen is displayed as shown in Figure 23.

i®l Admin Tools [_ O]

Op«wSpeechD

ATTENDANT

Start

Stop

b anitar

Directary Search

Prampt Recorder

Phone Directon and Menu Editor

FRepart Generataor

Backup / Restare

Drata impoart

Help

Figure 23: Admin Tools
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5.1. Administer Settings in the Configuration Panel

To open the Configuration Panel, click on this option in the Admin Tools window in Figure
23. The login prompt will be displayed to the user as shown in Figure 24. Log in with the
appropriate credentials using Level 2 access level.

Configuration password I

Aocezs level

I Lewvel 2 j

Paszword

Ixxxxx)1

ak I Cancel

Figure 24: Configuration Panel Login Window

The Configuration Panel shown in Figure 25 is displayed. The Configuration Panel allows
the transfer mode and operator extension number to be configured. Nuance OSA supports blind
transfers with Avaya IR. To enable OSA for blind transfers, set the Default Transfer Options
to UNSUPERVISED and Gateway Transfer Mode Bridged field to NO as shown in the figure
below. The Operator Extension Number field should be set to a valid extension on
Communication Manager. Click Apply.

&l Configuration panel - level 2

File Tools Help
Setting | | Current value | Defaul :I Gateway Transfer Mode Bridged
Server Trace Level DEY DEWV
Dump zession logs enabled ALWAYS ALWwAYS IND j
destination $LOCUS_DATAE  $LOCUS_DATAS
style PROGRESSIVE ~ PROGRESSIVE
Dump session stats enabled [y} oM
destination $LOCUS_DATAS  $LOCUS_DATAS
number of days to keep in databaze i} i}
CLID exclusion list
Mumber of Ports 1 1
Authorized numbers for DTMF pass through IMTERMAL OMLY  INTERMAL QOMLY
@ Default Transfer Options -+ UNSUPERVISED  SUPERWISED
@ Gateway Transfer Mode Bridged MO MO
Action on missing phone number AMMOUMCE &M... ANMOUMNCE AMD OFFE
Action on invalid phone number TRAMSFER TRAMSFER
Gateway Tranzfer Connection Timeout 35 35
Gateway Tranzfer Mazimum Call Duration 36000 36000
Gateway Tranzfer Options String
Gateway Tranzfer Pauze Character p p
Gateway Tranzfer UR| type TEL TEL
Gateway Transfer SIP URI suffis lacalhast: 5060 lacalhast: 5060
Call Analyzer recorded channels MOME MOME
System Languages enlS en-lS
@ Operator Extension Nurnber - FE303 1]
Action on ranzfer to operator off duty AMMOUMCE AM...  ANMOUMCE AMD TRAR
Operator access before first name search [y} oM
TDD Operator Extengion Mumber 1] 1]
Speed-Dial Key 1 1] 1]
Speed-Dial Key 2 9 9
Greed-Nisl Kan 2 a0 qq _ILI Restore |
4 | 3
Licenze
Figure 25: Configuration Panel
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Next, close the Configuration Panel. Activate the changes when prompted by the system as
shown Figure 26.

Warning! |

] ¥ou have made changes that require a system restart,
" Do ol wank ko da ik now?

Figure 26: Activate Changes in Configuration Panel

The following window is displayed. Click OK.

Starting Openspeech Attendant

Cpenspeech Atkendant skartup in progress

Figure 27: Startup in Progress Window

5.2. Administer Transfer Entries in Phone Directory and Menu Editor

From Admin Tools, click on the Phone Directory and Menu Editor option. Figure 28 is
displayed.

& Menu Editor =] B3

File Edt View Tools Help
E:l-"+ @}+‘Eﬁ; Eﬂ%|@‘!;[!0‘|[ﬁl %A‘*A

& B B G o v @l

Merus Content of 'Toplevel Menub!
ko o 2 T ) e 0 R R A
| )l Mame | Department | Location | SR | Murnber | Phane typel OTHF | Access ko name recorderl DTMF menu index |
'E Cellular Phones ®
‘ Croft, Lara = 77302 Office = S
1 entries selecked |
Phaone Directary | [Diata impart |

Figure 28: Phone Directory and Menu Editor
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Next, select File>New-> Transfer Entry from the menu options. The Creating transfer entry
window is displayed as shown in Figure 29. Configure the First names and Last names for this
entry and set the Number to a valid extension. Enable the Access to personal functions and
Access to name recorder options and set the PIN fields so that this user can access the Personal

Administration Mode (PAM) to change their name recording. Click OK.

Marne in director I [~ Deactivatedenty [~ DTMF Menu Index I
Mames |Advanced| Call A-:cc-untingl Inf-:-rmatic-nl S chedule IAIwa_l,ls j

Firzt names Middle names Last names | Always I

Dravid wells »

— — — ¥ Speech recognition
Mumber type Humber S U FM# Prw
[v |Office =||77a01 rerer .
r [ [ s s s |
Aliazes [English [US]]
Allow:

¥ Access to personal functions Fir I ”””””

[~ Voice biometrics

v Access bo name recarder Fassword I

Message [ one j Mew
[~ Mever propose this name Custam Prampt
Create Personal Directany | [elete Persanal Directony
Frevious MHew | [t | Ok Cancel Apply
Figure 29: Creating Transfer Entry
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The new transfer entry is now displayed in the Menu Editor window, but the entry has not been
activated yet. Click on the Activate Changes icon for the new entry to take effect.

& Menu Editor =1 3
File Edt View Tools Help
$ BB B o B0, G|, m Iy R ey
MEI’]US Content of "'Toplevel Menuy"
= R Toslevelbiens G 0 1 T 2 0 I T T S N N o N G N B N R A B R
| L MName | Department | Location | SR | Nurmber | Fhone typel DTHMF | ACCESE O name recorderl DTMF menu index |
E Cellular Phones ®
t Croft, Lara ® 77302 Office ® ®
[ /el David % 77301 Office
1 entries selected |
Phone Directory | Data import |
Figure 30: Menu Editor with New Transfer Entry
The following prompt is displayed to activate the new transfer entry so that it would be
recognized by Nuance OSA.
Change Activation
&n activation af the changes has been requested.
Figure 31: Change Activation
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5.3.

Administer Top-Level Menu in Phone Directory and Menu Editor

Nuance OSA allows the configuration of multiple entry points. The use of multiple entry points
enable individual services or departments to be assigned a different entry point, which can be
invoked based on DNIS or CLID number. When a call is received, Nuance OSA can route the
call to the appropriate entry point based on the dialed number (DNIS) or the caller’s phone
number (CLID). In this example, an entry point was configured using the DNIS option.

Create a new entry point by selecting File->New—>Top-Level Menu from the menu options.
The window in Figure 32 is displayed. Enter a descriptive name in the Aliases field, enable the
Access to name recorder option, and set the PIN field for use with PAM. Click OK and

activate the changes.

E.f Creating Menu

Mame in directary I

Mames |.-’-\dvanc:ed| EallAccountingI Infolmationl

First hames [l

iddle narnes Lazt hames

Aliazes [English [LI5]]

[~ DTMF Menu Index I

Menu Behavior | Securty .t’-‘n.cc:essl

I.t‘-‘«lways j

Access code I

¥ Call redirect permitted

Schedule

Drefault number

IAn_l,l tupe j

Converzation template

DRIS Test

IDefauIt j _I
Alwaysl
Hext step IDperatnr j_l
Action triggerl Mone j

Allow:

[~ Access to personal funchions
[~ Woice biometrics

¥ Access bo name recorder

[~ Mever propose this narme

PIM I"—
Passwaord I

Settings | Greetingl F'romptl Alemative F'romptl Help A I 'I

[v Speech recognition

j Mew |

Operator extension

IMenu biehavior 1

Mumber of utterances

IDefauIt j I

MNumber of spellings Yoice profile

IDefauIt j IDefauIt fram entry pon
Number of interactions Barge-in function

IDefauIt j IDefauIt fram entry poj

[~ Always azk for confirmation

[~ Listing of entries

Frevious I

IEnt |

Ok Cancel Apply
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From the Menu Editor, navigate to Edit->Ports and Entry Points to display the window in
Figure 33. Select the first item under Port assignment in the left pane and then select
Add~->Entry Point from the menu options. Figure 34 is displayed.

E{ Ports and Entry Points
Edt Add Wiew
—Port aszignment | [~ Port group
+ Hnassigned Forts | DNIS/CLID Summary
FOCROOM::1
[~ Show anly the entry points of I |l ﬂ
Delete Grou Mew Grou |
[~ Show anly the part groups of ] j P P

Cormputer Management... | Group Management | 0k | Cancel |

Figure 33: Ports and Entry Points
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In the Ports and Entry Points window in Figure 34, set the Home menu and Main menu to the
new entry point configured in Figure 32. Select the DNIS/CLID tab and enter the pilot number
associated with the appropriate VDN configured on Communication Manager. Click OK. In
this example, this entry point will be used when Nuance OSA receives a DNIS of 75201. Note
that the configuration of VDN 75201 and its associated vector are not shown in these
Application Notes, but should be configured as shown in Figure 8 and Figure 9.

@rotsondbniryports )
Edit Add wiew
—Port azzignment I —Entry paint
(= Port: POCROOM:1 o
. Default Menu Entry Point 1 Diescription IDNIS Test
- 7 MNew entry point Home men IDNIS Test ﬂJ
i Unassigned
b ain menu IDNIS Test jJ
[~ Transfer Connect
WII Settings  DMISACLID |.t'-‘«dvanc:ed|
DNIS | cuD
75201
[~ Show only the entry points of I All j
[~ Shaw only the part groups of ] j
Femave from Part Group Delete | M ew |
Computer Management... | Group Management | Ok | Cancel |
[Madified |
Figure 34: New Entry Point (DNIS/CLID Tab)
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In the VUI Settings tab, set the Voice Profile as shown below. Click OK.

ﬂ Ports and Entry Points [ x| |

Edit Add ‘Wiew

—Fort aszignment

= F'_u:urt: POCROOM:1

-~ Mew entry point
- Unaszigned

- Default Menu Entry Point 1

[~ Tianster Connect

Entry point
Description IDNIS Test
Home menu IDNIS Test jJ
k4 air menu IDNIS Test jJ

WUl Settings | DNIS/CLID | Advanced |

Yoice profile

[~ Express mode

" Barge-in off
£~ Barge-n on after first greeting
" Barge-in on after first prompt

Istandald, female voice

=1

{* DTHMF is globat
" DTMF iz local to EFP
[ Allow DTMF pass through

¥ Barge-in always Operatar Operatar
on duty off duty

Mumber of utterances 2 T 3 j

Mumber of zpelings 1 - 2 =

B e o s sl e o I 21l j Mumber of interactions 110 - m -

[~ Show only the part groups of ] j #S1R Ulieslis o I j

Remove from Port Group Delete | Mew |
Caomputer Management... | Group Management | ] | Cancel |

[Madifisd |

Figure 35: Ports and Entry Points (VUI Settings Tab)

A transfer entry was also added under the DNIS Test top-level menu using the procedure

described in Section 5.2.

&l Menu Editor |- (O] x]
File Edit Yiew Tools Help

$ BB A -G e, w0 R,

Menus Cartert of "DNIS Test\"

o Gl 2 2 ) A e B 0 0 S K

| Fl  Mame | Department | Location | SR | Murnber | Phone typel DTHF | Acocess ko name recnrderl DTMF menu index |
c Cane, Linda " F7304 Office " "
\Dentr\es |
Fhone Directory | [rata import |
Figure 36: Transfer Entry for DNIS Test Top-Level Menu
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5.4. Administer Caller Utterance Recordings

The Monitor tool available from the Admin Tools window allows a system administrator to
listen to caller utterances. To enable the recording of caller utterances, click on Configuration
Panel in Admin Tools shown in Figure 23 and log in using Level 3 access. Set the Call
Analyzer recorded channels parameter to ALL and set the Dump output documents enabled
parameter to ON (not shown). Apply the changes as described above. Caller utterances can then
be retrieved from the Monitor tool.

In the gateway.xml file located in C: \SpeechAttendant\OSA\www\WEB-INF\conf
directory of the Nuance OSA server, set the tag

<recordings recognized utterance media_ format> under the Avaya VP 5.1 section
to audio/basic. The default value is audio/x-wav. Restart Nuance OSA from Admin Tools to
enable the change.

From Admin Tools, click on Monitor and log in with the appropriate credentials. Click on Call
Logs in the left pane (not shown) to display a list of calls. Select the call for which you would
like to listen to the caller utterance. The caller utterance will be displayed as shown below and
may be listened to by clicking on the play / stop button.

ff?—'status of OpenSpeech Attendant (session) - Windows Internet Explorer

AI
Session started Mon Oct 25 14:20:06 ECT 2010
Sesszion id 1ECOD4T225FSFEDEE44R 22 IR DAZFIECE H = e e

DHIS 25200 zip session  print log previous next

CLID FFI02 1/ 50

Reverse lookup shared number

Calling name awir-0004cc5cc261db

Host { port [gateway) 10,22,24, 25 0 [avaya_vp)

Call duration 28 secs,

Cormnplexity scare 5

Termination code SRI1 (Speech call Routed on 1st Interation)

Destination wiells, David

Cormrment transfer completed

Tagging code ReRe

Error RoRE

Utterances
Utterances
:i;]) David wells accepted 0.91 rnenul0ooon
| whaole call recording not available for this call
iy play J stop
|-
.
Figure 37: Caller Utterance
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6. General Test Approach and Test Results

The interoperability compliance test included feature and serviceability testing. Feature testing
focused on Nuance OSA successfully recognizing spoken names and extensions entered via
DTMF, and then transferring the call to the correct destination. Blind transfer was verified.
Other features covered included barge-in / no barge-in, adding new transfer entries, recording
caller utterances, and accessing Maintenance Mode and Personal Administration Mode to record
name and change PIN. Avaya IR and the Nuance Speech Server were configured to use
MRCPvl1.

Serviceability testing focused on verifying the ability of the Nuance OSA to recover from
adverse conditions, such as server restarts, power failures, and disconnecting cables to the IP
network.

All test cases passed.

7. Verification Steps

This section provides the verification steps that may be performed to verify Nuance OSA with
Avaya IR.

1. From the Avaya IR web interface, verify that the Avaya IR channels are in-service as
shown in Figure 22.

2. From the Avaya Communication Manager SAT, verify that the T1 channels are in-
service using the status station <extension> as shown in Figure 38.

status station 23201 Page 1 of 4
GENERAL STATUS
Administered Type: DS1FD Service State: in-service/on-hook
Connected Type: N/A
Extension: 23201

Port: 01A1101 Parameter Download: not-applicable
Call Parked? no SAC Activated? no
Ring Cut Off Act? no
Active Coverage Option: 1 one-X Server Status: N/A
EC500 Status: N/A Off-PBX Service State: N/A

Message Waiting:
Connected Ports:

Limit Incoming Calls? no

User Cntrl Restr: none HOSPITALITY STATUS
Group Cntrl Restr: none Awaken at:
User DND: not activated
Group DND: not activated
Room Status: non-guest room

Figure 38: Status Station
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3. From the Avaya IR web interface, click on Display Status under Speech and DRP
Administration in the left pane to check the status of the Nuance Speech Server. In the
resulting page (not shown), select the Speech Resource Status link and then select the
Resource Status associated with the ASR server associated with the Nuance Speech
Server (e.g., OPSR4). Click Submit. The following page will be displayed. Check that
the ASR ports are INSERYV'.

AVAYA

Interactive Response Wab-Administration

b |
Avaya IR 4.0

Interactive Response 4.0

? Halp O Log Off

; Expand All

P ASG Security Administration
}Backup/Restore

* Configuration Management
and Administration

} System Control

} Switch Interfaces
} Digital Interfaces
} Voice over IP

}Voice Equipment
}Voice Services

* Feature Packages
F ASAI Administration
CTI DIF Administration

* Speech and DPR Administration
* Display Status

Speach Rescurce Status
Speech Server Status

Help
¥ Administration

Universal Call ID Administration
FROI-TCO Feature

}Reports

<

Optional: Area for display of application messages.

|

RESOURCE: QPSR4 SUMMRRY MRCEvl

SERVER: 10.32.24.140/mediz/speechrecognizer

Binding IP: 10.32.24.35 Base Port: 4300
PORT CRPACITY: 4 PORTS AVAILRBLE: 4

FORTS AVAILABLE:

4

: 10.32.24.140
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4. From the Avaya IR web interface, click on Display Status under Speech and DRP
Administration in the left pane to check the status of the TTS ports on the Nuance
Speech Server. In the resulting page, select the Speech Resource Status link and then
select the Resource Status associated with the TTS engine associated with the Nuance
Speech Server (e.g., TTS0). Click Submit. The following page will be displayed.
Check that the TTS ports are INSERV.

n |

AVAyA Interactiv eA:::paogsRetlg

Interactive Response Web-Administration ? Help & Log Off

i Expand All

P ASG Security Administration

RESOURCES: TIS
Defzult Voice: samantha

TTS0 SUMMRRY MRCEwl TOTAL PORTS AVAILRBLE: 4

P Backup/Restore
SERVER: 10.32.24.140/media/speechsynthesizer  IP: 10.32.24.140
'Confignrati_m_l Management Binding IP: 10.32.24.35 Bzse Port: 4500
and Administration PORT CRPRCITY: 4 PORTS AVAILRBLE: 4
} System Control PORT STRATE CHAEN

¥ Switch Interfaces
} Digital Interfaces
}Voice over IP

INSERV N/R
INSERV N/R
INSERV HN/R
INSERV HN/R

}Voice Equipment -

Wk O

* Voice Services

* Feature Packages
FASAI Administration

CTI DIF Administration
* Speach and DPR Administration
- Display Status

Speech Resource Status
Speach Server Status
Help
} Administration
Universal Call ID Administration

} ROI-TCO Feature

}Reports

< >

Optional: &rea for display of application messages.

h > |
Figure 40: TTS Status Summary

5. Place a call to Avaya IR and verify that the Nuance OSA application answers the call,
that the greeting is heard, and that the application is able to recognize the speech and
DTMF tones provided by the caller and transfer the call to the correct destination.
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6. From Admin Tools on Nuance OSA, start the Monitor to verify that an active call is

detected as shown in Figure 41.

OpenSpeech Attendant’

Hosted on pocroom

DescHption: Auto Attendant Yersion: OS54 40,0 (with F01) (latest hot fix installed d00HFDE, $00HFOZ, SO0HFOE)

Sections SR
Summary
Summary status Uptirne: 0 days 0 hours 16 rminutes 28 seconds,
Reports Served 39 total (21 currently in merory)
sessions:
Alarms
Served 3]
ts:
EDosh Servist kb
[ Erwiranment

Configuration
D Installation log
(] Manitaring

Telephony M, 2 calls sa far for pacraam,

notifications:

Sent Alarm

2, (Mon Oct 25 14:30:30 EDT 2010)
notifications:

Pozsible fronel

4

1 calls in progress (concurent peak 1, Mon ©ct 25 14:30:10 EDT 2010)

10.32.24.35
S Replication Monitor CHM St.atus Calls DNIS CLID EF Function
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Figure 41: OSA Monitor

JAO; Reviewed:

SPOC 11/16/2010

Solution & Interoperability Test Lab Application Notes
©2010 Avaya Inc. All Rights Reserved.

35 of 38
Nuance-OSA4-IR




7. From the OSA Monitor, click on Call logs in the left pane. Verify that the call log shown
in Figure 42 is displayed with the correct call information and status.

openSpeech Attendant’

Hosted on pocroom

Descrption: Auto Attendant Wersion: OS54 4,0,0 [tk FOX) (fatest bot fix installed $O0HFOI, FOOHFIZ, SO0HFOE)

Sections CALLLOGS

Summary status Select period: Filker by call termination codes:

Reports Datefrom [to/zsizotn L)

|»

ADMT - Announce number but Do Mot Transfer (C5)

e Dateto  [lo/zizoto L B - Busy (INF)

BGC - Busy on Sperator (INF)

CC - Cancelled by Caller (INF) =l
= 03h Servlet
D EnviFrnnment Filter by: Filter by call complesity: Filter by call duration:
i Configuration 5 m_ I = l I
D Installation log DHIS |Starts WIthLI I == i Feconds e

L | Monitoring CLID |Starts with »| |

Iall types 'I Ilast 50 calls 'I Submit

= Replication Manitor
[ Replication Status
D Replication Errors

Logs (From database), showing first 50 out of 81 sessions ... too many sessions.

3 3 3 call Termination s System _

call start DNIS  CLID complexity e Destination  “¥#'orl Tagging

25/10/2010 75200 FT3I01 S 27 SRI1 Croft, Lara transfer completed

17:07:08

2571072010 T3IZ00 TT303 3 47 SRI1 Cane, Linda transfer completed

17:05:08

25/10/2010 7Sz00 T30 [u] 14 HG Toplevel Menu  caller hangup

17:01:52

25/10/2010 75200  TFT7I04 =l 20 SRI1 Wells, David transfer completed

153:21:35

251072010 75200  TFT304 S 2z SRI1 Wells, David transfer completed

14:48:17

254102010 75200  TFT7302 a5 75 HP &AM Toplevel Manu  caller hangup

14:46:52

25/10/2010 75200 TT30Z 35 101 HP &M Toplevel Menu  caller hangup

14:40:07

25/10/2010 75z00  TFTz0Z 23 35 HPAM Toplevel Menu  caller hangup

14138152 hd|
4 | b

Figure 42: Call Log
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8. Support

To obtain technical support for Nuance OpenSpeech Attendant, contact Nuance via email or
through their website.

= Web: www.network.nuance.com
= Email: SpeechAttendant.Support@nuance.com
= Phone: (866)434-2564 or (514) 390-3922

9. Conclusion

These Application Notes describe the configuration steps required to integrate Nuance
OpenSpeech Attendant with Avaya Interactive Response (IR) using MRCPv1. All feature and
serviceability test cases were completed successfully.

10. Additional References

This section references the product documentation that is relevant to these Application Notes.

[1] Administering Avaya Aura™ Communication Manager, Release 6.0, Document 03-300509,
Issue 6.0, June 2010, available at http://support.avaya.com.

[2] Avaya Aura™ Communication Manager Feature Description and Implementation, Release
6.0, Document 555-245-205, Issue 8.0, June 2010, available at http://support.avaya.com.

[3] Avaya Interactive Response 4.0 Administration Guide, December 2008, available at
http://support.avaya.com.
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